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Chapter 1: Welcome to SourceBridge
This document describes SourceBridge, an extension that enables developers to associate
source code control files with SBM items.

Audience and scope
This guide describes how to install, configure, and use SourceBridge.
This guide is meant for SBM users who install and use SourceBridge on their workstations.
Typically, SourceBridge is used within an integrated development environment (IDE) to
associate source code control files with SBM items. You can also use SourceBridge from
within the Serena PVCS Version Manager 8.1 and later.

Guide to SBM Documentation
The SBM documentation set includes the following manuals in PDF format. Most
documents are installed with SBM; to obtain a document that is not installed with the
product or to download the complete documentation set, visit http://www.serena.com/
support.
Manual
®

Description

Serena
Business
Manager
Installation
and
Configuration
Guide

Provides information on installing SBM and creating a database.
Database and Web server configuration information is also provided.

SBM
Composer
Guide

Provides details on using SBM Composer to create the tables, fields,
workflows, orchestrations, and other design elements comprised in
process apps. Information about saving, versioning, importing, and
exporting process apps is also provided. This document is intended for
individuals who want to design and maintain process apps.

SBM
Application
Administrator
Guide

Provides information on using Application Administrator to deploy
process apps to runtime environments and to promote configured
applications from one environment to another.

SBM System
Administrator
Guide

Provides information on configuring and administering the SBM
Application Engine. Instructions for managing projects, user accounts,
system settings, and authentication are included.
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Manual

Description

®

Provides information about the SBM User Workspace and is intended
for end users. Instructions on using the SBM User Workspace, including
the robust reporting feature in SBM, are included. To ease the process
®
of providing a copy for every user in your system, the Serena
Business Manager User's Guide is provided in PDF and can be accessed
from the Product Information tab of the About page in the SBM
User Workspace.

®

Explains how to manage licenses for Serena Business Manager.
License types are discussed, along with instructions for installing and
using the Serena License Manager. This guide is intended for
®
administrators who will install and implement Serena Business
Manager.

Serena
Business
Manager
Web Services
Developer's
Guide

®

Provides an overview of all SBM Web services, including descriptions
for all calls, arguments, and responses. Installation instructions and
information about the sample Web service programs are also provided.

SBM
AppScript
Reference

Provides information on customizing SBM using SBM AppScript, a
programming language built around VBScript 4.0. This guide is
intended for VBScript programmers who want to use SBM AppScript to
implement custom features in an SBM system.

Moving to
®
Serena
Business
Manager

Provides migration information for existing TeamTrack customers who
are moving to SBM. It explains how to upgrade your existing system,
and it explains the expanded SBM paradigm in relation to the
TeamTrack paradigm.

Serena
Business
Manager
User's Guide

Serena
Business
Manager
Licensing
Guide

®

Accessing Online Help
SourceBridge User Help provides information to end users about operating
SourceBridge.
To access help, click the Help button located on each dialog box.
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Chapter 2: Installing and Configuring
SourceBridge
SourceBridge is an extension that allows you to associate source control actions with SBM
items and record version control history in SBM. SourceBridge intercepts check-out,
check-in, undo check out, and add file processes to allow you to associate source files
with SBM items. The source control processes are captured and recorded in the SBM
database as well as in the source control environment.
SourceBridge can be used with integrated development environments that comply with
Microsoft Source Code Control Interface (MSSCCI) standards, such as Serena PVCS
Version Manager. You can also use SourceBridge from within supported versions of
Serena PVCS Version Manager.
• Installing SourceBridge [page 7]
• Source Control Registry Settings [page 7]
• Configuring SourceBridge [page 9]

Installing SourceBridge
SourceBridge is installed on each user's machine. Before installation, the integrated
development and source control environments must be installed and configured.
To use SourceBridge, you must be granted the "Logon from SourceBridge" privilege. The
"Logon from SourceBridge" privilege also enables you to create, run, modify, and delete
Version Control Actions reports in the SBM User Workspace. Contact your SBM
administrator to determine if you have been granted this privilege.
In addition, select the Version Control History check box on the Display tab of your
user profile in SBM. This setting allows you to view version control history in the SBM User
Workspace.

Source Control Registry Settings
The SourceBridge installation modifies the system registry to allow SourceBridge to insert
itself between the integrated development environment and source control.

Understanding the Registry Settings
The following figures show how the SourceCodeControlProvider key is displayed before
and after SourceBridge has been installed.
The following figure shows the Windows registry editor before the SourceBridge
installation. The ProviderRegKey points to the source control provider.

SourceBridge User's Guide
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The following figure shows is the Windows registry editor after the SourceBridge
installation. The ProviderRegKey points to SBM. The prior setting of ProviderRegKey is
saved in SerenaCopyofOriginalProviderRegKey.

The SourceBridge installation also adds registry keys to the
Local Machine\Software\TeamShare\SourceBridge folder, as shown in the following
figure. The UnderlyingSCC key points to the source control provider that is intercepted
by SourceBridge.
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Troubleshooting the Installation
When SourceBridge is installed, the ProviderRegKey points to the
Local Machine\Software\TeamShare\SourceBridge folder. If SourceBridge is
reinstalled without first uninstalling, the ProviderRegKey value is copied without first
checking to see if SourceBridge is already installed and your development environment
may be unable to locate your source control provider. Repeated reinstallations may crash
the development environment. To fix this problem, uninstall SourceBridge through the
Add/Remove Programs Properties dialog box located in the Windows Control Panel,
then reinstall.
In addition, if you upgrade or re-install your source control tool, you must update the
ProviderRegKey to point to the Local Machine\Software\TeamShare\SourceBridge
folder.

Configuring SourceBridge
Before using SourceBridge, you must provide the SBM Web server location, your SBM
login ID and password, and your source control provider. These settings are made on the
System Settings tab of the Settings dialog box, which automatically opens when you
try to check a file in or out for the first time after installing SourceBridge.
You can also open the Settings dialog box manually using the following methods:
• Click the Source Control icon located on your IDE toolbar.
• Depending on your IDE, select Source Control from the Project menu in the IDE.
For example, in Microsoft Visual C++, select Source Control from the Project
menu, and then select your source control provider, such as Serena PVCS Version
Manager.
• In Serena PVCS Version Manager, select SourceBridge from the Tools menu.
When the SourceBridge dialog box opens, click the Settings button to open the
Settings dialog box to the System Settings tab.

Configuring System Settings
The following options can be set on the System Settings tab of the Settings dialog box.
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• SBM Server - Type the name, IP address, or URL of the SBM Web server. For a
secure connection, type the URL of the SBM Web server, including the https://secure
protocol.
• SBM Login ID - Type your SBM login ID.
• SBM Password - Type your SBM password.
• Connect via Proxy Server - Select this check box to connect to the Web server
through a proxy server. You may also enter a URL here.
• Verify Connection - Click this button to verify that SourceBridge can connect to the
SBM Web server. If SourceBridge is unable to connect to the SBM server, modify
information in the SBM Server, Login ID, and Password boxes as needed or verify
with your SBM administrator that the Web server is running.
Note: If you are using SourceBridge within the Serena PVCS Version
Manager Windows client, the following options are not available.
• Launch Source Control Provider - Click this button to launch the source control
provider configured to work with SourceBridge.
• Switch Provider to - Select the source control provider you want to use from the
drop-down list. This list is populated with all source control applications that comply
with MSSCCI standards that are installed on the your machine. You must restart
your development environment after selecting a new source control provider.
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Configuring User Settings
The following options are available on the User Settings tab of the Settings dialog box.
Note: Your administrator can override certain settings. Settings that have
been overridden by your administrator are disabled and marked with an
asterisk. Settings that cannot be changed are disabled.

• Show Association Dialog on Checkout - Select this check box to open the
SourceBridge - Check Out dialog box each time source files are checked out. This
enables you to associate SBM items with the files being checked out. The Show
Association Dialog on Checkout check box is selected by default. Note that this
setting has no effect when SourceBridge is used through the Serena PVCS Version
ManagerWindows client.
▪ Association Required - This check box is enabled if the Show Association
Dialog on Checkout check box is selected. Select the Association Required
check box to require that at least one SBM item is associated with the file or files
being checked out. By default, this check box is cleared.
• Show Association Dialog on Checkin - Select this check box to open the
SourceBridge - Check In dialog box each time source files are checked in. This
enables you to associate new SBM items with the files or to modify associations
made at check in. This option also opens the SourceBridge - Add to Source
Control dialog box each time you add files to source control. By default, the Show
Association Dialog on Checkin check box is selected. Note that this setting has no
effect when SourceBridge is used through the Serena PVCS Version Manager
Windows client.
▪ Association Required - This check box is enabled if the Show Association
Dialog on Checkin check box is selected. Select the Association Required
check box to require that at least one SBM item is associated with the file or files
being checked in or added to source control. By default, this check box is cleared.
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▪ Show Only if No Associations - This check box is enabled if the Show
Association Dialog on Checkin check box is selected. Select the Show Only if
No Associations check box to open the SourceBridge Check In dialog box if
file or files being checked in are not already associated with an SBM item. By
default, this check box is selected.
• Cleanup Associations on Undo Checkout - Select this check box to automatically
remove check out records from SBM items when an undo-checkout operation is
performed. Clear this check box to log undo checkout records and to store check out
records in SBM when an undo checkout operation is performed. By default, the
Cleanup Associations on Undo Checkout check box is cleared.
• Tag Source Control Comment With Associations - Select this check box to
record SBM item associations in the comments area for each file's source control
properties for some source control environments. For details, refer to SBM Data in
the Source Control Tool [page 23].
▪ Include Change User Info - Select this check box to include your SBM user
name and login ID in the comments area for each file you associate with items as
you perform check out and check in operations. By default, this check box is
selected.
▪ Before Existing Comment - Select this option to add SBM association
information to the beginning of existing comments.
▪ After Existing Comment - Select this option to add SBM association information
after existing comments. This option is selected by default.
▪ Tag - Specify a format for association information added to comments. The tags
can be made up of text and the following data identifier tags:
▪ $id - Returns the Item ID for the SBM item.
▪ $ownid - Returns the login ID of the user who owns the SBM item at the time
of the association.
▪ $project - Returns the name of the project in which SBM items reside at the
time of the association.
▪ $recid - Returns the SBM item's database record ID.
▪ $tableid - Returns the SBM item's database table ID.
The default tag is $id($tableid,$recid) $title.
• Ask for Transition (During Checkin or Uncheckout) - Select this check box for
SBM to prompt you to transition items on completion of associated check in and
undo check out operations. By default, this check box is cleared.
• Quick Association - Select this check box to associate SBM items selected in the
Results list on the SourceBridge Check In or SourceBridge Check Out dialog
boxes with the files being checked in or out. The enables you to quickly associate
items without clicking the Associate button in the Associations area. By default,
this check box is cleared.
• Use Version Labels on Checkin - This setting is available when Serena PVCS
Version Manager is used as the underlying source control system. Select this check
12
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box to add a version label to the file that contains the SBM Item ID when you check
in files.
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Chapter 3: Using SourceBridge
SourceBridge enables you to associate source control actions with SBM items from within
the development environment and record these actions in SBM and the source control
environment. You can also search for SBM items and launch SBM.
For details, refer to:
• Using SBM Within SourceBridge [page 15]
• Associating Items With Source Control Actions [page 17]
• Accessing SourceBridge Information in SBM [page 22]
• SBM Data in the Source Control Tool [page 23]

Using SBM Within SourceBridge
The SourceBridge dialog box enables you to work with SBM items from within the
integrated development environment or from within Serena PVCS Version Manager.
Specifically, you can use the SourceBridge dialog box to:
• Search for items you have privileges to transition and launch SBM to open to those
items.
Note: SBM items are associated with source control files using the
SourceBridge - Check In, SourceBridge - Check Out, and
SourceBridge - Add to Source Control dialog boxes. For details, refer to
Associating Items With Source Control Actions [page 17].
• Launch the SBM User Workspace.
• Launch your source control application, if applicable.
• Access SourceBridge system and user settings.

SourceBridge User's Guide
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You can open the SourceBridge dialog box using the following methods:
• Click the Source Control icon located on your IDE toolbar.
• Depending on your IDE, select Source Control from the Project menu in the IDE.
For example, in Microsoft Visual C++, select Source Control from the Project
menu, and then select your source control provider, such as Serena PVCS Version
Manager.
• In Serena PVCS Version Manager, select SourceBridge from the Tools menu.
The following options are available on the SourceBridge dialog box:
• Project (Includes Sub-projects) - This option enables you to filter searches by
projects in which you have privileges to transition items. If a parent project is
selected from the drop-down list, items are returned from the parent project and any
of its sub-projects.
• Keyword(s) - Use the Keyword box to search for information in Text fields that
are set up for keyword searching by your administrator. Keyword searches typically
apply to the Title and Description fields, but may include other fields as well. Type
the keyword you want to use for the search in the Keyword box. Separate multiple
keywords with a space. To find an exact phrase, enclose the phrase with quotation
marks. Asterisks (*) serve as wildcard characters.
• Item ID: To find items by ID, type the Item ID in the box. The following criteria
applies to Item ID searches:
▪ Prefixes specified with the ID number are ignored.
▪ Leading zeros on the ID number may be left off your search criteria. For example,
to find item ID number "BUG00017," type "17."
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▪ Wildcard characters are automatically prepended and appended to your search
criteria.
▪ If you provide search criteria in the Keyword(s) and Item ID boxes, the Keyword
criteria is ignored, and the search is based on the Item ID criteria.
▪ If multiple items with the same ID number are found in a project and its
descendant, each of these items is added to the Search Results list.
▪ If a single digit is typed in the Item ID box, each item in the database with an
Item ID that includes that digit is returned. For example, if 5 is typed, items with
ID numbers 5, 52, 75, and so on are returned.
• Filter on Active/Inactive - This option enables you to list active items you can
transition, inactive items you can transition, or both.
• Show Only Items I Own - Select this check box to list all items you own in the
specified project and its sub-projects. Clear this check box to list all items you can
transition in the specified project and sub-projects. If the Show Only Items I Own
check box is cleared, you must specify a keyword or item id as search criteria.
• Append Search Results to List - Select this check box to add search results to the
existing Search Results list. Clear this check box to replace the Search Results list
with search results.
• Search - Click Search to search for SBM items based on specified criteria.
• Search Results - Items meeting the search criteria are listed in the Search
Results list. The list displays the Item ID, Title, Owner, Project, State, and Active/
Inactive status for each item.
• Item Details - Select an item from the Results list, and then click Item Details to
open the SBM User Workspace to that item.
• Launch SBM - Click this button to launch SBM. You can then work with reports,
submit items, etc.
• Launch Source Control Provider - Click this button to launch the source control
provider configured to work with SourceBridge.
• Settings - Click this button to open the Settings dialog box and set system and
user settings. For details, refer to Configuring System Settings [page 9] and
Configuring User Settings [page 11].

Associating Items With Source Control Actions
SourceBridge leverages the development environment's integration with version control
software; therefore, unless you are using Version Manager, all files must be checked in
and checked out from within the IDE to be recorded in SBM. If you are using Version
Manager and SourceBridge is properly installed and configured, file operations performed
from the source control environment are recorded in SBM.
The process for checking files in and out depends on your source control application and
integrated development environment.

SourceBridge User's Guide
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Associating SBM Items With Check-Out Actions
Depending on your user settings, the SourceBridge - Check Out dialog box opens when
you check out files from the IDE or Serena PVCS Version Manager. If you are using
Serena PVCS Version Manager, you can also click the Associate Issues button on the
Check Out File dialog box to open the SourceBridge - Check Out dialog box.
The SourceBridge Check Out dialog box is used to associate SBM items listed in the
Results list with source files being checked out. The check-out actions are then recorded
in the SBM database and can be viewed in the Version Control History section of
associated items in SBM if you have selected the Version Control History display option
in your user profile. Depending on your user settings, these actions are also recorded in
the source control environment. For details, refer to Configuring User Settings [page 11]
and SBM Data in the Source Control Tool [page 23].
Tip: Click the Launch SBM button to open the SBM User Workspace.

To associate SBM items with files on check out:
1. Using the search mechanisms described in Search Options [page 20], locate SBM
items to associate with files being checked out.
2. Associate SBM items with the files being checked out, as described in Association
Options [page 21].
3. Click Complete to finish your action or Cancel to abort your action.

Associating SBM Items With Check In Actions
Depending on your user settings, the SourceBridge - Check In dialog box opens when
you check files in from the IDE or from Serena PVCS Version Manager. For details on user
settings, refer to Configuring User Settings [page 11].
If you are using Serena PVCS Version Manager, you can also click the Associate Issues
button on the Check In File dialog box to open the SourceBridge - Check In dialog
box.
Tip: Click the Launch SBM button to open the SBM User Workspace.

To associate SBM items with files on check in:
1. Using the search mechanisms described in Search Options [page 20], locate SBM
items to associate with files being checked in.
2. Associate SBM items with the files being checked in, as described in Association
Options [page 21].
3. Click Complete to finish your action or Cancel to abort your action.

Transitioning Items On Check In or Undo Checkout
You can transition items upon completion of associated check in and undo check out
operations.
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If you are associating multiple SBM items with the version control operation, SourceBridge
prompts you to transition each item individually. This enables you to select different
transitions for individual items as needed. If required fields need data, SourceBridge
prompts you to finish the transition in SBM. SourceBridge also prompts you to finish the
transition in SBM if you selected a special transition type, such as Copy, Post Item, or
Publish Problem.
If multiple files are associated with an SBM item, you are prompted to transition the item
when you check in the last file or you "undo" the check out on the last file.
To use the transition feature, you must select the Ask for Transition check box on the
User Settings tab of the Settings dialog box. For details, refer to Configuring User
Settings [page 11].
To transition items using SourceBridge:
1. After the file check in or undo check out operation completes, the SourceBridge
Transition Item dialog box opens. The Item ID and Title of the first item selected
are shown in the Item Information area.

2. Select the appropriate transition from the Available Transitions list, and then click
one of the following options:
• Launch SBM - Click this button to launch the SBM User Workspace to the
Transition form for this item. You can then update items as needed and
transition them manually.
• Execute - Click this button to transition the selected item. Click Yes to launch
SBM and finish the transition. Click No to cancel the transition.
Note: The version control operation is completed before the transition
prompt is given, so cancelling the transition does not cancel the version
control operation.
• Skip - Click this button to record the version control operation in SBM without
transitioning the item.

SourceBridge User's Guide
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Associating SBM Items With Add to Source Control
Actions
Depending on your user settings, the SourceBridge - Add to Source Control dialog box
opens when you add files to source control, enabling you to associate SBM items with
these items. For details on user settings, refer to Configuring User Settings [page 11].
Tip: Click the Launch SBM button to open the SBM User Workspace.

To associate SBM items with files being added to source control:
1. Using the search mechanisms described in Search Options [page 20], locate items to
associate with files being added.
2. Associate SBM items with the files being added, as described in Association Options
[page 21].
3. Click Complete to finish your action or Cancel to abort your action.

Search Options
Search options are used in the SourceBridge Check Out, SourceBridge Check In, and
SourceBridge - Add to Source Control dialog boxes. The following search options are
available:
• Project (Includes Sub-projects) - This option enables you to filter listed items by
projects in which you have privileges to transition items. If a parent project is
selected from the drop-down list, items are returned from the parent project and any
of its sub-projects.
• Keyword(s) - Use the Keyword box to search for information in Text fields that
are set up for keyword searching by your administrator. Keyword searches typically
apply to the Title and Description fields, but may include other fields as well. Type
the keyword you want to use for the search in the Keyword box. Separate multiple
keywords with a space. To find an exact phrase, enclose the phrase with quotation
marks. Asterisks (*) serve as wildcard characters.
• Item ID: To find items by ID, type the Item ID in the box. The following criteria
applies to Item ID searches:
▪ Prefixes specified with the ID number are ignored.
▪ Leading zeros on the ID number may be left off your search criteria. For example,
to find item ID number "BUG00017," type "17."
▪ Wildcard characters are automatically prepended and appended to your search
criteria.
▪ If you provide search criteria in the Keyword(s) and Item ID boxes, the Keyword
criteria is ignored, and the search is based on the Item ID criteria.
▪ If multiple items with the same ID number are found in a project and its
descendants, each of these items is added to the SourceBridge Check Out list.
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▪ If a single digit is typed in the Item ID box, each item in the database with an
Item ID that includes that digit is returned. For example, if 5 is typed, items with
ID numbers 5, 52, 75, and so on are returned.
• Filter on Active/Inactive - This option enables you to list active items you can
transition, inactive items you can transition, or both.
• Show Only Items I Own - Select this check box to list all items you own in the
specified project and its sub-projects. Clear this check box to list all items you can
transition in the specified project and sub-projects. If the Show Only Items I Own
check box is cleared, you must specify a keyword or item id as search criteria.
• Append Search Results to List - Select this check box to add search results to the
existing Results list. Clear this check box to replace the Results list with search
results.
• Search - Click Search to search for SBM items based on specified criteria.
• Results - Items meeting the search criteria are added to the Results list. The list
displays the Item ID, Title, Owner, Project, State, and Active/Inactive status for each
item. Double-click an item to add it to the Associations list, or select an item, and
then click Associate.
• Item Details - Select an item from the Results list, and then click Item Details to
open the SBM User Workspace to that item.

Association Options
Association options are used in the SourceBridge Check Out, SourceBridge Check In,
and SourceBridge - Add to Source Control dialog boxes. The Associations area enables
you to associate files being added, checked in, or checked out with SBM items in the
Results list. Files that are being checked out, checked in, or added to source control are
listed under the All Files root folder in the Associations list. Once SBM items are
associated with the files, the items are listed under each file.
Tip: SourceBridge remembers the last SBM item or items associated with
source files by automatically selecting them the next time a file is checked out
or added to source control. When you check items in, SourceBridge
automatically remembers the last item associated with source files if you have
opted not to associate items with files on check out. If an item has been closed
or you no longer own it, it does not automatically show up in the Results list.
The following Association options are available:
• Associate - Associate selected files in the Associations list with SBM items in the
Results list by selecting the files, and then clicking Associate. Multiple items can be
selected by pressing CTRL and clicking each item. Items are associated with files as
follows:
▪ If the All Files root folder is selected, the association is made for all files in that
folder.
▪ If files are selected under the root folder, the association is made for the selected
files.
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▪ If an SBM item is selected and no files are selected, the Associate button is
disabled.
Note: If you associate an SBM item and a file at check in, the version
control record in SBM does not contain any check out information.
• Unassociate - Remove SBM item associations from files by selecting files or items in
the Associations list, and then clicking Unassociate. Items are unassociated from
files as follows:
▪ If the All Files root folder is selected, you are asked if you want to remove all
associations for all files. Click Yes to remove associations; click No to keep
associations intact.
▪ If a file is selected, you are asked if you want to remove all associations for the
file. Click Yes to remove associations; click No to keep associations intact.
▪ If an SBM item is selected, it is moved from the Associations list.
Note: If you remove the association between an item and a file during
check in, the version control record is deleted from SBM.
• Item Details - Select an SBM item that is associated with a file, and then click Item
Details to launch SBM to that item.

Related Topics
Associating SBM Items With Check-Out Actions [page 18]
Associating SBM Items With Check In Actions [page 18]
Associating SBM Items With Add to Source Control Actions [page 20]

Accessing SourceBridge Information in SBM
You have two methods of accessing SourceBridge information in SBM:
• Version Control History - The version control history associated with each primary
item can be viewed in the Item Details frame for that item. Refer to the Version
Control History [page 22] for details.
• Version Control Actions Report - This report type allows you to generate reports
based on items associated with files checked in or checked out, date ranges, and
users performing version control actions via SourceBridge. Refer to the Version
Control Actions Report [page 23] for details.

Version Control History
In SBM, all checkout and check-in operations performed using SourceBridge are displayed
in the Item Details page for individual primary items and can be viewed if you select the
Version Control History check box in your SBM user profile. If you choose to record
undo check out operations, these are recorded as well. If you select the Cleanup
Associations on Undo Checkout option in your SourceBridge user settings, however, all
check out associations are deleted.
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The Version Control History section contains names of the files associated with an item,
the date and time files were checked in and out, the SBM user who performed the source
control action, and comments associated with check-in actions. Depending on your source
control tool, the version number of the file associated with the SBM item may be displayed
as well.
SourceBridge does not need to be installed for you to view the Version Control History in
the SBM User Workspace, but if your application uses custom forms, the Version Control
History section must be included on the form. If you cannot view the Version Control
History section, contact your system administrator.
Note: If your administrator grants appropriate privileges, you can add,
modify, and delete version control actions, also referred to as file associations,
from within SBM.

Version Control Actions Report
Version control actions can be retrieved by Version Control Actions reports. Version
Control Actions reports allow you to access information pertaining to source control files
associated with SBM primary items. You can generate reports based on items associated
with files checked in or checked out, date ranges, SBM users performing version control
actions via SourceBridge, and more. File association information is also available. For
®
details on working with Version Control Actions reports, refer to the Serena Business
Manager User’s Guide.
Note: Privileges granted by your administrator determine if you can create,
run, modify, and/or delete reports. In addition, to access Version Control
Actions reports, you must be granted the Logon From SourceBridge system
privilege.

SBM Data in the Source Control Tool
SourceBridge can record SBM association information in each file's source control
properties for some source control tools. This enables you to trace information related to
SBM items from within the source control tool. To enable this feature, select the Tag
Source Control Comment With Associations check box in your SourceBridge user
settings. For details, refer to Configuring User Settings [page 11].
Each time a file is checked in or checked out and associated with an SBM item in the
integrated development environment, information about the item is added to the
comments entered. Depending on the action you are performing, these comments are
stored in the Comment field in the file's check out status properties or the file history
Comment field in the source control environment.
Note: Comment fields are commonly used in source control applications that
adhere to the MSSCCI standard. They may be accessed differently or not at all,
depending on the development environment and source control applications
being used.

SourceBridge User's Guide
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By default, SourceBridge adds the SBM user's name, login ID, item ID, and comments to
the Comment field. Additional information is also stored with each Item ID to allow the
item to be uniquely identified in the SBM database. You can customize comment setting in
your SourceBridge user settings. For details, refer to Configuring User Settings [page 11].
Note: The number of characters that can be appended to the Comment field
varies depending on the source control application and the length of the
comment entered when the file is checked out. The data appended by
SourceBridge may be truncated by the source control application if the total
length of the comment exceeds the maximum it allows.
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